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BUILDING A SUCCESSFUL SPA

Tomado de: Spa Therapy.com

Step One — Conception
by John Fanuzzi

John Famuzzi: is the founder of Golden Rato Woodworka, Inc., 8 laadng manutactunes of
bochswark, therapy and spa equipment. Binhed as 8 ona-man operation 20 years ago, Galdan
Fatio maw boasts mene than 100 emplayees and is one o the mas! respected comparnies in tha
massage and spa industry. Jobn is also lounder of The Wellspring Instilute, a training and
retreat cenber 1hal hosts workshops for health practitioners, aestheticians, and professionals in
the hialing ans, including hands-on training in techniques and treatmiants.
BN aLg. com

As | write for Massage Today, whose primary readership is massage therapists,
| am honored fo share seme of my experiences with many friends in the
industry. Looking through the eyes of a massage therapist and through the eyes
of a hoted chain are complately differant. so 1 will write as it | was a massage
therapis! considering opening a spa.

"Spa” seems 1o be the wildcard word that incorporates not just massage, but a
potential multitude of treatments, including other alternative therapies; bady
scruls; skin care; steam; sauna; hydrotharapy; yoga: litnass; diet; meditation;
and cleansing. It is the universal and much more socially accepted word, and it
has hit its stride anly in the past six or seven years. With that window now open,
many massage therapists are upgrading their practices 1o day spas, which can
be quite profitable il properly planned and managed,

When inspired with a new idea, such as opening a spa, a process starts that will
test you, to sea if you have what it takes 1o fulfill that vision, Many peogle get
sidetracked when someone, perhaps their closest friend or most respected
lawyer, banker or accountant. questions tham aboul the practicality of thair
dream. Will your passien ar your fears win when you hit thal obstacle? My
experience tells me that with any good idea, there are always hurdles o
overcome. The real beginning i when you say, ™1 will.” From that peint of
commitment, ihe fun bagins. | have labeled this Conception -- the firsi step of a
12-step process 1o building a successhul spa. Sharing your vision with your
cloge circle of partners or s1all, who also have a positive vision, will multiply the
ideas and keep the creative juices flowing. It is also a time 1o start 0 think about
what type of corporate struciure you might need, and who the principals will be.
Your positive attitude will bring the birth of a beautiful business; it must be
nurtured, just like a baby in the womb,

| have personally built two spas, and one thing | can say s that what your final
product may be quite different than your conceptual plan, When you do get imo
the design stage, you wani (o be as close o the final desied resull as possible
or it will detay construction and cost more for changes,
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These are the steps you need to follow for this: Select all the rows, including the header row up to the last row in your sheet (which is usually row 1000). Press the ‘Set Permissions’ button. We again create the basic outline of this tab, which consists of a specified cell where the user will enter the search string. But if you enter the names in a
consistent format i.e. FirstName LastName OR LastName, FirstName, then it will make it easier for you to search your contact list. Click here to view and download our Address Book template. Related Posts: You will find a small pink search box that lets you enter your search string in this worksheet. To use this template, click File->Make a copy.
Search contacts by name To search your contacts by name, click the “Search by Name” tab, and then enter the name that you are searching for in cell Al. There are lots of people who like to keep their contact list in Google Sheets, including myself. For more information about the QUERY function, you can go through this article. Conclusion We tried
to provide you with a detailed tutorial to help you create your own Google Sheets Address Book template, so that you can customize it to your own requirements. You can share an address book with family members, colleagues or team members and work on it remotely in real-time. Note: Any additions/deletions/edits to the contacts should only be
done from the ‘Contact List’ tab. Get the contact list template See more Google Sheets templates If you want to search for specified contacts, you there are also two tabs that allow you to do this very easily. In our formula, we specified that we want to sort all the rows starting from cell A2 up to the last row of column D (which are in the worksheet
named ‘Contact List’). This breaks the monotony when you have a large number of contacts to look through. Now, the entire sheet is protected, except for the cell B1, where the user can enter the search string. This will display an input box for entering the range of cells you want to exclude from protection. sort_column is the column by which you
want to sort the data in the range. Creating the Sorted Contact List Worksheet Once the Contact list is created, you can create a new worksheet that will display the sorted contact list. Creating the Basic Outline of the Contact List Let us start with the basic outline of our Contact List. Protecting the Search List Tab from Accidental Changes If you type
anything in the results area of the QUERY function, it might result in a #REF! error. You can search by Name or part of the Email address. Once the basic outline of your contact list is created, you can start adding in your contact details. This will open the Alternating Colors sidebar, from where you can select the color formatting that you want to
apply. Now add the field headers for the contact list. I hope that this contact list template makes storing and finding your contacts much easier! A few years back almost everyone had an address book where they stored all their contacts along with phone numbers and addresses. An address book template or a Google Sheets Contact List
Template consists of a grid with details about contacts, like Name, Phone Number, Address and Email Address. Formatting the List to Show Each Row in Alternating Colors You can format your contact list to display rows in alternating colors. Select ‘Sort A-Z’ to sort the contact list in alphabetical order of names. Now you can start typing the formula



to display the rows that match the search string. In this tutorial, we will show you step by step how to create a Google Sheets Address Book template that you can further customize according to your requirements. We also put some basic formatting in place so that alternating rows are displayed in alternating colors. The syntax for the QUERY
function is: QUERY(data, query, [headers]) Here, data is the group of cells that you want to perform the query on query is the SQL-like query that you want to apply to the data. You can also use this tab to make edits to existing contacts or delete contacts that you don’t need. With spreadsheet software like Google Sheets, maintaining and sharing
address books has become easier and more efficient. The SORT function is dynamic, so any changes you make to the original contact list get automatically updated in the result of the SORT function. Simply press the ‘+’ button near the worksheet tab as shown below: This will create a new worksheet with the name Sheet2. This tab is connected to the
Contact List tab so that every time you make a change to the original data in the Contact List, the contents in the Sorted Contact List get automatically updated with the changes, while still keeping the rows sorted. We created a random list of contacts as shown below, just to demonstrate this tutorial: Using Filters to Sort the Google Sheets Contact
List Template At this point, you can choose to add filters to your contact list to sort your list by name. A more effective way would be to have a separate tab that displays the sorted contact list dynamically. Note: Cells in this template that should not be edited have been protected, and the sheet will display a warning message if you try to edit them.
Next, we create the ‘Search List’ tab. This opens the Protected sheets & ranges sidebar. A TRUE value indicates ascending order, while a FALSE value indicates descending order. However, if you prefer to simply download a ready-made template rather than create one from scratch, you can go ahead and download our template from this link. It is
also quite useful to have a search feature in the template, so that the user can easily find the contacts they need without having to scroll through the entire list. This requires identification of the fields that you want to include in your address book. The query basically says that we want to select all the rows from the given range where the name or the
email address contains the search string in Bl either at the start, middle or end. You can use spreadsheet software to keep your contact list organized and quickly find contacts using a simple search string. If the QUERY function does not find any matching rows, it might return an error code. To change the name of the worksheet tab, simply double
click over the worksheet tab name and write over it with the new tab name, ‘Contact List’. This function lets you apply SQL-like queries on a given range of cells. You can select one of the default styles or create your own custom style. Now, every time a user wants to edit the sheet, they will be given a warning message. Understanding the Template
Design The template that we will create in this tutorial is organized into three tabs: Contact List Sorted Contact List Search List Let us look at what each of these tabs are meant to achieve: The Contact List Tab The Contact List tab is meant to simply let you add contacts to the list. The template also has a tab that organizes your contacts
alphabetically, and automatically, as you continue adding new contacts to each new row in the “Add Contacts” tab. You can either explicitly sort the list every time you add a new contact, or have the list automatically sorted using the SORT function. Search contacts by letter To search your contacts by letter, click the “Search by Letter” tab, and then
enter the letter that you want to filter by in cell Al. If they select Cancel then the changes will be undone, and if they select OK, then the changes will remain. The above two parameters are compulsory in a QUERY function. Additional parameters can be added to sort the range by more criteria. We want to sort the range by column 1 (which in our
selected range is the 1st column). One tab will allow you to search/filter by the contact's first letter (of their name), and another tab will allow you to search by name (or partial name). We also add the main headers below which the search results will get displayed, along with other basic formatting. Alternatively you can click on the ‘Create a Filter’
button from the main toolbar: This will add filters to your dataset. Here’s how our sorted contact list looks: Note: Sorting the contact list in this way is not very efficient, because you will need to re-sort the list every time you add, remove or edit an entry. We specified the is_ascending parameter as TRUE because we want the rows sorted in ascending
order. Protecting the Sorted Contact List Tab from Accidental Changes If you type anything in a cell of the ‘Sorted Contact List’ sheet, it might result in an #REF! error. Here’s the default style that we selected: You should now find your rows in alternating shades of your selected colors. To sort the “Add Contacts” tab, right-click at the top of column
A, and then select “Sort sheet A-Z”. Using the SORT Function to Create the Sorted Contact List To create the sorted contact list, you only need to know one formula: =SORT('Contact List'!A2:D,1,TRUE) The above formula uses the SORT function, which simply displays the sorted data into a range of cells that start from the cell containing the formula.
Type B1 in this input box, as shown below: Press the ‘Set Permissions’ button Select ‘Show a warning when editing this range’ and press Done. Check the box next to ‘Except certain cells’. Once the basic skeleton is ready, you can start filling in the contact details. This will sort your main tab where you add contacts (even though the second tab does
this automatically), and will not affect any of the formulas on the rest of the sheet. Creating the Search List Worksheet To allow the user to search for specific contacts from the contact list, you can create a third worksheet and name it ‘Search List’. To ensure that this doesn’t happen, you can protect the all the cells of the ‘Search List’ sheet (except
for cell B1) by the following steps: Right-click on the worksheet’s tab Select ‘Protect Sheet’ from the context menu that appears. Usually this is specified as an index number of the column in the given range. Select ‘Show a warning when editing this range’ and press Done. You can also enter a part of the name, and the formula will still show you
contacts that match that criteria. Try to make this cell stand out from the other cells by changing the background color. The Sorted Contact List The Sorted Contact List tab simply organizes your original contact list by sorting the rows in alphabetical order of Names. This opens the Protected sheets & ranges sidebar. To ensure that this error code is
not displayed, we wrap an IFERROR function around the QUERY formula. Insert the above formula in cell A4 of your ‘Search List’ worksheet, and press the return key. Here are the steps you need to follow: Select all the column headers of your contact list From the Data menu, select ‘Create a Filter’. is_ascending can be a TRUE or FALSE value.
Insert this formula in cell A2 of your ‘Sorted Contact List” worksheet, and press the return key. The template should either automatically sort the rows containing contact information or at least give the user the option to sort it by pressing a button. For your convenience, we have also shared a ready-made template that you can simply download and
start using immediately. Using the QUERY Function to Display Required Rows To display the contacts that match the search string entered by the user (in cell B1), you can type the following formula in cell A4: =IFERROR(QUERY('Sorted Contact List'!A2:D, "select * where A contains ""&B1&"' or C contains ""&B1&"™)) The above formula uses the
QUERY function. If any of these three fields match the given search string even partially, the row corresponding to that contact will get displayed in this tab. You should now see all your contact list entries sorted by Name in this sheet. What Does an Address Book Template Consist of? You should see all matching entries from your contact list sorted
and displayed in this sheet. Below this cell, add the same headers that you had used in the other two sheets. From the Format menu, select ‘Alternating colors’. Design the outline of this sheet as in the image below: As you can see, this sheet has a specific cell where users can enter their search string (cell B1). You can enter the name of your
contacts in any format that you want. You can also use Ctrl+F on your keyboard to search for contacts while on the main tabs that show every contact. It also ensures that the user can easily distinguish between rows while skimming through the data. Now try entering a search string in cell B1 and press the return key (It can be a part of a Name

or Email Address). These address books were organized with alphabet tabs, so that you could easily find the contact you need by skipping to the appropriate tab. The above three parameters are compulsory in a SORT function. There are two ways to do this. For example, in this tutorial we will include the following fields: Name Phone Number Email
Address Address We create these fields along with their headers in a worksheet that we name ‘Contact List’. It specifies if cells in the range should be sorted in ascending or descending order of sort column. The Search List Tab The Search List tab is meant to help you quickly find contacts using a search string. Once done, you can add the formula to
display the sorted list in this worksheet. The automatically sorted list will get saved in a separate tab, which is the ‘Sorted Contact List’ tab. To ensure that this doesn’t happen, you can protect the sheet by the following steps: Right-click on the worksheet’s tab Select ‘Protect Sheet’ from the context menu that appears. Again we will make sure that
the user cannot make edits to the search results area. Get your copy of the contact list template To use the contact list template, follow these instructions and store any relevant information that you have for each contact: Click on the “Add Contacts” tab; Each blank row in this tab is for a single contactEnter the contact's name in column AEnter the
contact's phone number in column BIf the contact has a second phone number, enter it in column CEnter the contact’s email address in column DEnter the contact's physical address in column EClick the “Alphabetize” tab to see your contact list sorted automatically You can also sort the “Add Contacts” tab itself, by following the instructions below.
This will let you edit and save the sheet as your own. All you need to do is click on the filter (or arrow next to) the Name column header. How to Create a Google Sheets Address Book Template / Google Sheets Contact List Template To create a Google Sheets address book template, we start by creating the basic outline. The filters appear in the form
of triangles next to the each column header, as shown below: Now you can sort your rows by Name. In the Google Sheets contact list template that is linked below, you can enter your contact information in a very organized way. We hope our address book template makes it convenient for you to organize, store, find, and share your contacts more
easily. Change the name of the sheet to ‘Sorted Contact List’: Again create the same column headers as you did in the Contact List worksheet and format the sheet with alternating colors for readability. You can then sort your contacts in alphabetical order of Name. If you have a nice template that is ready to use and that has the ability to easily filter/
search for contacts, Google Sheets becomes an even more amazing place to store contact information. In this tab, we also make sure to protect the sheet so that the user does not accidentally write over it. In our formula, we specified that we want the query “select * where A contains "&B1&”‘ or C contains "&B1&”"” to be applied to the range
starting from cell A2 up to the last row of column column D (from the worksheet named ‘Sorted Contact List’). Since we don’t need these parameters in this example, we will not go over them, but if you are interested, you can go through this article to understand the SORT function better. The syntax for the SORT function is: SORT(range,
sort_column, is _ascending, [sort column2, is ascending?2, ...]) Here, range is the group of cells that you want to sort. This is especially helpful as your contact list starts getting bigger with time. You can add the field headers shown in the image below: You can also put your own headers according to your requirement, but you have to make sure that
you use these same headers to display your data in the other tabs as well.
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